
 

www.targit.com/university  www.targit.com/community 

 

 TARGIT Visualization Wizard 
Level: Intermediate 

TARGIT Decision Suite 2019.0 – document version 1.4 US 





 

TARGIT Visualization Wizard                                                                                         Page 3 of 117 

Copyright  

No part of this publication may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying or recording, for 

any purpose, without the express written permission of TARGIT A/S, Denmark. 

 

© 2019 TARGIT A/S, Denmark. All rights reserved, including the right of 

reproduction in whole or in part, or in any form. 

 

  

 

 

TARGIT A/S  

Gasværksvej 24  

DK-9000 Aalborg  

Denmark  

Phone: (+45) 9623 1900  

Telefax: (+45) 9623 1999  

 

E-mail: info@targit.com  

Internet: http://www.targit.com 

  

http://www.targit.com/


 

TARGIT Visualization Wizard                                                                                         Page 4 of 117 

Contents 
Introduction ..................................................................................................... 7 

Lesson 1: Preparations, Templates .................................................................... 9 

Basic Templates ............................................................................................ 9 

Templates with Placeholders ........................................................................ 13 

Lesson 1 Exercises ....................................................................................... 15 

Lesson 2: Text and KPI objects ....................................................................... 19 

Text box objects .......................................................................................... 19 

KPI objects .................................................................................................. 23 

Lesson 2 Exercises ....................................................................................... 25 

Lesson 3: Menus ............................................................................................ 29 

Menu objects for Start pages ....................................................................... 29 

Adding a Menu object ............................................................................... 29 

Menu Item Templates ............................................................................... 34 

Triggers – shortcuts to other documents .................................................... 36 

Menus for general navigation ....................................................................... 37 

Working with Stored menus ...................................................................... 38 

Role based menus ....................................................................................... 39 

Exercises Lesson 3 ....................................................................................... 41 

Lesson 4: Trigger behavior ............................................................................. 45 

Exercises Lesson 4 ....................................................................................... 46 

Lesson 5: Advanced Labels ............................................................................. 49 

General ....................................................................................................... 49 

Titles ........................................................................................................... 49 

Labels ......................................................................................................... 52 

Mouse over ................................................................................................. 55 

Conditional axis formatting ........................................................................... 62 

Exercises Lesson 5 ....................................................................................... 65 

Lesson 6: Drill Downs and Required Criteria .................................................... 67 

Drill down objects ........................................................................................ 68 

Required criteria .......................................................................................... 72 

Criteria ranges with custom values ............................................................... 75 

Exercises Lesson 6 ....................................................................................... 78 



 

TARGIT Visualization Wizard                                                                                         Page 5 of 117 

Lesson 7: Slideshows ...................................................................................... 83 

Exercises Lesson 7 ....................................................................................... 86 

Appendix ........................................................................................................ 87 

Selected Visualization Objects ...................................................................... 87 

General chart properties ............................................................................ 87 

Bullet Graph ............................................................................................. 89 

Area map chart ............................................................................................ 93 

General map options ................................................................................. 93 

Changing the map image .......................................................................... 95 

Mapping of dimension values..................................................................... 96 

Labels formula syntax .................................................................................. 99 

Column/row and axis calculations .............................................................. 99 

Gauges – for Dashboards ........................................................................... 101 

Start with a basic crosstab ...................................................................... 101 

Gauge Properties .................................................................................... 102 

General .................................................................................................. 103 

Values .................................................................................................... 104 

Scale and Labels ..................................................................................... 105 

Gauges – build your own ........................................................................... 109 

Gauge Builder App Download .................................................................. 110 

 





 

TARGIT Visualization Wizard                                                                                         Page 7 of 117 

Introduction 

The purpose of this course is to give you the tools for planning and designing a 

TARGIT solution with maximum focus on end-user on-boarding and end-user 

engagement. 

You are probably one of the key resources when it comes to building TARGIT 

analyses, dashboards and reports – not just for yourself, but also for most other 

TARGIT users within your organization. 

When end-users access your TARGIT solution, they should feel that: 

• The requested data was easy to find. 

• The provided analyses and dashboards was easy to read and understand. 

This manual was created with one thought in mind: To make your TARGIT 

end-users as engaged as possible. 

By making a TARGIT solution attractive to your end users, you will raise the 

chance that your colleagues will accept and start using the solution to its full 

capabilities earlier than expected – and thus getting full value of the investment 

quicker than expected. 

To make a TARGIT solution as attractive as possible, you should consider: 

• A user-friendly approach to navigate TARGIT documents. 

• Consistency in how you create and design your TARGIT documents. 

• A few tips & tricks that make your analyses and dashboards stand out. 

This training manual will teach you all of this – and a lot more. 
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Note: Many of the demos and exercises in this manual work with graphics that 

can easily be created or downloaded from the Internet. Alternatively, download 

the graphics directly from portal.targit.com, in the Download Center.  

 

 

Go to Other Dowloads: 

 

 

In the TARGIT University section you may want to download a couple of .ZIP 

files: 

 

 

http://www.mytargit.com/
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Lesson 1: Preparations, Templates 

One of the corner stones in supplying a consistent and robust experience to the 

end-users are templates. 

Without templates, you will most likely end up with a messy looking TARGIT 

solution where each analysis, report or dashboard that is opened will look 

fundamentally different from the other ones. 

With documents based on the same template(s), end-users will spend less time 

on figuring out how to use the document in front of them, and more time 

focusing on the information within the data. 

Basic Templates 

When you create a new document in TARGIT you do this on a blank page, a 

canvas, of a certain size. 

This page size would typically be measured in pixels and conform to a 4:3, 16:9 

or 16:10 etc. format. 

Initially, when you create a new document you may only have a couple of pre-

defined templates: “Blank dashboard” and “Blank report”. In this manual we will 

focus on Dashboard documents only, but we will create a few extra templates, in 

different sizes, ready for use when we create new documents. 

Start out by creating a new document with the built-in Blank dashboard 

template: 
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The new blank dashboard will normally have a page setting at 1920 x 1080 

pixels, but you can select one of the other pre-defined sizes or even create your 

own, custom size: 

 

Now, save this new page size as a template in a folder you created for the 

specific purpose of storing templates: 
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Go back the Start tab, on the Open tab, to right click the newly created 

templates folder to “Add folder to templates”. 

 

From now on, when you create new documents, the templates that you save in 

this folder will be available from the Start / New tab. 

 



 

TARGIT Visualization Wizard                                                                                         Page 13 of 117 

Templates with Placeholders 

The Placeholder object is very useful in combination with templates. With the 

Placeholder object you can allocate an area on your canvas that should later be 

replaced by a “real” object, e.g. a Crosstab, a Bar chart, a KPI object etc. 

 

The Placeholder can be placed and resized like any other object. If necessary, 

you can use the X, Y, Width and Height boxes in the lower right corner to be 

even more precise about size and placement. 

 

The Placeholder objects will go into your Object list. It is recommended to 

rename the objects in the object list – especially if you end up with many and 

overlapping objects on your canvas. 

 

  



 

TARGIT Visualization Wizard                                                                                         Page 14 of 117 

Then, with placeholders, you can create a template where you can ensure 

consistent placement and sizes of your objects. 

 

When using the template, select a placeholder to replace it with a “real” object. 
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Lesson 1 Exercises 

(Screenshots and exercises are based on version 2019.0 demo data. If you are working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Task 1 

Prepare your TARGIT solution with a number of basic dashboard templates: 

• 1280 x 720 pixels 

• 1600 x 900 pixels 

Save these templates in a Templates folder in the Shared folder – and make 

sure that you “Add folder to templates”. 

 

Task 2 

Prepare another 3-4 dashboard templates, all 1600 x 900 and all incorporating 

placeholders. 

Notice that the Title placeholder has already been replaced by a real Textbox 

object in these templates. What are the benefits of including a “real” object in a 

template? 

Examples that might try to replicate: 
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Task 3 

Use one of your templates to create this Dashboard: 

 

Save the Dashboard as Lesson 1 Products and Markets Dashboard. 

 

Object definitions: 

• Spline chart: Revenue and Profit per Time YMD (hierarchy). 

• Bar chart: Revenue per Product (attribute). Top 10 function applied. 

• Crosstab: Revenue per Customer Country (attribute) and Time Year 

(attribute). 
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Lesson 2: Text and KPI objects 

In this lesson we will focus on two commonly occurring objects in dashboards: 

The Text box object and the KPI object. 

Note: The term “Text box” is actually a bit misleading. A Text box object doesn’t 

necessarily contain text – it may contain an image or a background color, without 

anything else. 

 

Text box objects 

A Text box object is one of the rare objects that does not hold any data. 

Typical use cases for Text box objects are: 

• Titles for Analyses, Dashboards and Reports. 

• Displaying a company logo or any other kind of image. 

• “Explanation boxes” with tips and guidelines on how to best use the 

analysis. 

• “Information boxes” with e.g.: 

o Current criteria 

o Dynamic dates 

o Cube processing date and time 

o Etc. 
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The Text object has numerous options with regard to Layout types (pure text, 

pure image, a combo or nothing but a background color) and with regard to 

formatting of the individual elements. 

In this example it is being used as a pure text object: 

 

A very strong feature of the Text box object is the ability to work with dynamic 

content: 
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Dynamic content offers a wide range of useful options. In this example we would 

like a dynamic expression of the last 12 months. We do that by selecting Month 

and Year members from our Time dimension, and furthermore setting the Range 

property to First or Last. 

 

Having selected, one at a time, Month (first), Year (first), Month (last) and Year 

(last), we will end up with something like this: 

 

Eventually, if we apply the Previous 12 months dynamic criteria from our Time 

dimension, the Text object would dynamically display something like this: 
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KPI objects 

In general, a KPI object is an object suitable for displaying high level, current 

values of important measures. 

While focus is on the measure value itself, proper use of additional text, images 

and color could further support the presentation of the value. 

A KPI object is limited to a maximum of three measures. However, if more are 

needed, you would simply insert as many KPI objects to your analysis as you 

need. 

When you start designing a new KPI object, it will default to a single-value KPI 

object. So, one of the first things you would normally want to do, is to go into 

Properties to change the KPI image: 

 

Notice that a TARGIT installation comes with a set of pre-defined KPI images – 

organized in two folders, System images and System images with icons. You can 

in fact add you own images (SVG images) in the Images folder root, or in a new 

folder you may have created for that purpose. 
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The pre-defined System images folders contains different variations of KPI 

images that has been designed to show 1, 2 or 3 measure values. 

 

In this example, we have chosen a KPI image with the maximum number and 

types of elements. Any KPI image can work with maximum: 

• One Title 

• Three Values 

• Three Labels 

• Three color indicators – which can be controlled through Color agents. 

Note: If you need to display multiple KPI values on your dashboard, you may 

consider to add these as single-value KPI objects rather than multi-value KPI 

objects. With the ability to freely arrange objects – overlapping and transparent – 

you can, in many cases, obtain better results with multiple single-value KPI 

objects. 

KPI images works with a default font type, as defined in the source SVG file. 

However, disable it to select your own custom font: 
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Lesson 2 Exercises 

(Screenshots and exercises are based on version 2019.0 demo data. If you are working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Task 1 

Create a Sales Dashboard (based on the Sales cube) that looks like this: 
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Save the dashboard as Lesson 2 Sales Dashboard. 

 

When creating the dashboard, pay attention to these settings: 

• Page size: 1600 x 900. 

• Add the Customer Territory dimension to the Criteria bar. 

• Dynamic content in text box: Sales Dashboard {TerritoryMembers} 

• Map is showing Profit Margin per Customer Country (attribute). 

• Color agents on Profit Margin KPI follow same rules as color agents on 

map. 
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Task 2 

Apply filters: 

• From Criteria bar: Customer Territory = Europe 

• Drill down filter: Fortunato Crawford 

Verify that you get this result: 

 

 

Task 3 

Save three versions of this dashboard, with global criteria corresponding to their 

names: 

• Sales Dashboard Asia 

• Sales Dashboard Europe 

• Sales Dashboard North America 

We will use these three versions in one of the upcoming lessons. 
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Lesson 3: Menus 

With TARGIT, you can have users to start with a specific document whenever 

they open the TARGIT app from their Desktop. This is an administrative feature 

of the Roles management within TARGIT, where you can have members of 

different roles to start on specific documents. Very often, this Start document will 

be the same document for all users. 

Many organizations have implemented a structure of inter-connected documents 

– from the Start document to one or more levels of details documents, and back. 

In this way, the end-users will experience that all their data requirements can be 

answered by the documents within the navigation structure. 

TARGIT offers a Menu object that has been designed specifically to support such 

a navigation structure. 

Menu objects for Start pages 

A common Start page is often designed as a document with shortcuts that will 

navigate end-users to different business and data areas. 

You may include data on the Start page, but then as simple KPI objects – and 

from these KPI objects you will very often include shortcuts to documents with 

even more detailed data anyway. 

Adding a Menu object 

Go to the Design tab to add a Menu object:  
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This will insert the Menu object at the top left of your analysis: 

 

Click “New menu” if indeed it is a new menu you are about to create. 

Think of a Menu as a number of buttons. In the dialog, this is called Menu items. 

Right click the Menu items list to add a new menu item:  
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Notice that Menu item properties are identical to Text / Layout object properties: 

 

If you just add a couple of menu items with caption text in both and click OK, 

you may end up with an object like this, where the width of the menu items 

seem to be determined automatically by the width of the texts inside them: 
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Going back to the Menu object Properties, we can see that the default orientation 

is Horizontal – hence why the two Menu items appeared next to each other. 

 

If we change the general Menu property to Vertical, and at the same change the 

Height property from Auto to a fixed height, we can make the menu look a lot 

more consistent. 
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Furthermore, if we need a number of similar menu items, you can easily 

accomplish this by duplicating a menu item as many times as you like. 

 

The result, with a vertical menu and duplicated menu items with fixed heights, 

may then look like this: 
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Menu Item Templates 

Any menu item’s appearance is defined by a Template. The advantage of 

templates becomes clear when at some point you will need to change the 

general style of your menus. 

Let us say that you have designed all of your menu items with a style matching 

your company’s current identity. Now, if that identity should change at some 

point, all you need to do is to change the template, which will then update all 

menu items across all your documents. 

If you already created a number of differently styled menu items, you can then 

save each of these styles as a new template: 

 

The saved templates are available from the Templates tab, from where you can 

edit existing templates or add new ones. 
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When you add a new Menu item, you can now apply one of the existing 

templates: 

 

The new Menu item will then take on all the properties from the template, 

including text, font style etc. To override a property coming from the template, 

you must first click the toggle button “Using template value / Using user defined 

value”: 
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Triggers – shortcuts to other documents 

One of the main purposes of a Menu is to provide shortcuts to other documents. 

When you click a button (a menu item) in a Menu, you will very often want it to 

open a specific document. 

This functionality is handled by Triggers in TARGIT. 

To set up a trigger on a menu item, click the Add trigger option and select the 

document you would like to open with this trigger. Also, consider if the document 

should be opened with its own saved criteria only. 

 

At this point you could replace the static Caption text with some dynamic 

content. Click the two curled brackets symbol next to the Caption box. In this 

case, we could make good use of a System variable, the Trigger – document 

title. 
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The result is, that the menu item text will automatically reflect the document title 

of the triggered document. 

 

 

Menus for general navigation 

When designing a navigation structure, you will probably need a standard 

navigation menu to be added to most of your documents. E.g. you will almost 

always need buttons for these purposes: 

• Home. To bring the end-user to the Start analysis. 

• Back. To bring the end-user back to the previous document. 

• Help. A link to internal or external documentation on how to use TARGIT 

within your organization. 

 

These types of menus are often built purely with image buttons as in the 

example above, which, of course, requires that you have some suitable graphics 

available. 
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Next thing would be to apply the corresponding trigger options to these buttons, 

e.g.: 

• Home. Document trigger to specific analysis. 

• Back. “Open previous document”. 

• Help. URL link to internal or external documentation on how to use 

TARGIT within your organization. 

 

Working with Stored menus 

A menu that is supposed to be inserted in multiple documents, should be stored 

to a file. 
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When you want to re-use the stored menu file in another document, simply 

insert a Menu object and choose the Insert menu from file option: 

 

When working with stored menus you will gain a huge advantage when it comes 

to modifications to the menus across you documents. Now you only need to do 

the modification in one place: The stored menu. The changes you add to the 

stored menu will automatically take effect in all documents where the stored 

menu has been inserted. 

 

Role based menus 

The third and last option when inserting menu objects is to insert a Role based 

menu. 

Different end-users can be members of different roles – and for each role, you 

can define a specific menu to be inserted as the Role based menu. The menu 

you select, must be one already stored on the system. 

Role properties, including assigning specific menus to specific roles, are managed 

through the TARGIT Management client: 
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In the TARGIT client, you may now insert a menu as a Role Based menu in one 

or more of your documents. The inserted menu is then automatically selected 

according to the end-user’s role properties. 

 

In other words, when one user (from one role) opens the analysis in which you 

inserted the role based menu, he or she will see one menu. When another user 

(from another role) opens the same document, he or she will see another menu. 
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Exercises Lesson 3 

(Screenshots and exercises are based on version 2019.0 demo data. If you are working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Notice: The graphics that have been used in the exercises below can be 

downloaded from the TARGIT Portal, http://portal.targit.com. 

Go to the Download Center / Other Documents / TARGIT University and look for 

SVG Navigation Buttons. 

Task 1 

Create this Start analysis from text based menu objects: 

 

 

Tips: 

• The menus are in fact four vertical menu objects – each with five menu 

items. 

• Create and use two styles: Blue background and text, White background 

and text. Both with a border. 

Save the document as Start Analysis in the Shared folder. 

 

  

http://portal.targit.com/
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Task 2 

Create a new menu object with some general navigation buttons: 

 

The four buttons: 

• Home. Go to the Start page. 

• Back. Go to previous document. 

• Back with drill state. Go to previous document, and keep its drill state. 

• Remove all drill downs. 

Save the general navigation menu and insert it in the three documents: Asia, 

Europe and North America. 

 

Tips: 

• It may be necessary to create a new style template for the buttons: 

Graphics only with background color. 

• Save the menu object – in order to re-use it across all three documents. 
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• Test it: Now, can you navigate from the Start Analysis to each of three 

documents – and back? 
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Lesson 4: Trigger behavior 

The default behavior of an Open document trigger is to transfer all criteria from 

the first document to the triggered document. The transferred criteria includes 

Global, Local and Drill Down criteria. 

A typical example is when we need to get even more details about data in a 

dashboard. We may then create a specific trigger button in the dashboard 

analysis to open the Detail document. 

The question is how this trigger should behave when activated? The options are: 

• Transfer all criteria from the source document to the target document. 

• Transfer selected criteria from the source document to the target 

document. 

• Open the target document with its own saved criteria only. 

Furthermore, when criteria are transferred, you can choose between replacing 

the target document criteria or merging with the target document criteria. 

When you add the trigger, you have an option to include or exclude (whichever 

is the easiest to administrate) all criteria or criteria from selected dimensions: 
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Exercises Lesson 4 

(Screenshots and exercises are based on version 2019.0 demo data. If you are working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Task 1 

Navigate to Sales Dashboard Asia, Sales Dashboard Europe and Sales Dashboard 

North America. 

• Add an extra menu to these analyses. The new menu is just a single 

button and it must be added individually for each dashboard (i.e. it 

cannot be saved and re-used). 

 
• The trigger from this button should point to a new Detail document. See 

below. Save this document as Sales Details. 

• Insert the General Navigation menu in the new document. 
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Task 2 

Try out some different trigger behaviors from the Details button in the three 

dashboards: 

• From Sales Dashboard Asia: 

o Open Sales Details document with Saved criteria only. 

• From Sales Dashboard Europe: 

o Open Sales Details document with transfer/replace all criteria. 

• From Sales Dashboard North America: 

o Open Sales Details document with transfer/replace all criteria 

except Salesperson criteria. 

 

Task 3 

Open the Sales Dashboard North America and add a trigger (transfer/replace all 

criteria) from the crosstab to the Sales Detail document. 

Now, what happens when you click one of the Salespersons in this crosstab? 
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Lesson 5: Advanced Labels 

The formatting options for titles, labels and mouse over allows you to show 

detailed information about the data behind the objects but still keep a tight 

analysis design.  

General 

All the formatting options can be found in the properties for the individual object. 

Right click the object to get access to the properties. 

 

The properties are very similar and uses drop-down menus. The number of 

“default” options varies from object to object. You can also open a text editor for 

more advanced formatting. We will walk through all three subjects in this demo. 

Titles 

In the object title, you can insert the measure option. This will change the object 

title dynamically if you use the measure selector in the analysis. 

 

The title can be translated and the font formatted if needed. 
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Now, add the measure selector to the criteria bar and see what happens when 

we change the measure. 

  

We can refine the title so that it shows the measure name, the grand total for 

the measure and perhaps an average. 

Click the small drop-down arrow to open the advanced text editor. 

 

Place the cursor to the right of {Measures} click the drop-down arrow again and 

select <New numeric value> 
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Now we have added a new value to the title. This value can be used in different 

ways but we just enter a simple calculation column.sum that calculates the 

total units sold. 

 

There are a number of different calculations. The most useful will typically be 

average (avg), total (sum), minimum (min) and maximum (max) calculations. 

 

E.g., this is how to add an Average function: 
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Labels 

The settings for showing labels are the same apart from the options for 

placement and rotation. 

 

This default option will show the result below. The dimension value and the 

measure value are shown for each column.   
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In the next example we add No of Sales and Revenue to our chart. The only 

reason for this is to be able to show the values in our labels, so we hide these 

measures through Properties / Visibility 

 

In the drop-down, click Custom and then Open advanced text editor. 
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We can use a fixed text as a prefix followed by the appropriate values {Value2}, 

{Value1} or {Value3} in whatever order you like. 
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Mouse over 

When you place your mouse on a dimension value in a chart, you can get more 

or less detailed information as shown above, so we are going to look at a few 

advanced options. 

One option could be to show if Units Sold for the managers is above or below the 

average Units Sold. 

 

Open the advance text editor again. 

 

We can combine placeholders for values with fixed text. Here we use two 

placeholders from the drop-down list, {RowMember} (Sales Manager) and 

{Value1} (Units Sold) and a fixed “is”. 
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Now we insert a conditional text (If – Then – Else). Click the drop-down arrow 

and select <New conditional text> 

 

Remove the number 1 in the “if” statement box and select Value1 in the drop 

down menu. 

 

Then enter the formula for testing if Value1 (Units Sold) is greater than 

Column.avg (Average). Next, click Apply. 
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Enter the text in the “Then” box. Click Apply. 

 

Next, click Else if to enter a text for the values that are less than average. 

 

Now enter the text “less than average” and click apply 
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Next, we create a new cross table with a comparison and a calculation in it. 

 

With a few adjustments, we get a result like this: 
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We want our mouse over to show combinations of fixed text and values for our 

comparison, our growth calculation and our dimension values. 

We open the advanced text editor right away: 

 

We type “Result for:” and select {RowMember} (Sales Manager). 

Nest, we type “Growth:” and find {Value2}, which we can see from the drop-

down, is Growth Percent Revenue. 

We type some more prefixes “Last year to date:” and “Year to date:” and finally 

find <New lookup for Revenue> 

 

We select this lookup twice and get the following result: 
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When we added the first lookup value, we got an extra tab in our diagram menu: 

 

The Revenue1 placeholder should point at the column with data for last year to 

date. The data is in the first column if we look inside the cross table. 
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Revenue2 should point at column2 which shows the data for this year to date. 
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Conditional axis formatting 

If you have a bar chart like the one below where there is a large difference in the 

data, then it can be difficult to rank the smallest bars or to be able to use them 

for drill-down because of their size. 

 

Let us reduce the maximum scale. 
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The bars that shows the lowest values have become more visible. 

 

However, at the same time some bars that “fall over the edge” because they 

represent values that exceed the axis maximum. 

We can clarify this if we add a conditional text for these bars. We grab the 

advanced text editor once more. 
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With additional formatting, we can get this result. 
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Exercises Lesson 5 

(Screenshots and exercises are based on version 2018.3 demo data. If you working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Task 1 

Create an analysis with… 

• Area map chart: Revenue per Customer Country (attribute). 

• Pie chart: Revenue per Product Hierarchy (Product Group). 

• Column chart: Revenue per Time hierarchy (Quarter). 

Add the measure selector to the criteria bar and make sure that the object titles 

reflect the measure selected. 

The analysis could look like this. Please notice criteria and selected measure. 

 

Observe the following: 

• Labels on all three objects. 

• Mouse over on Pie chart. 
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Moreover, when using the Measure selector to select Profit: 

 

Save the analysis as Lesson 6 Advanced Labels. 
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Lesson 6: Drill Downs and Required Criteria 

You can design your analyses to nudge the end-user through the objects in a 

desired sequence. You can insert specially designed objects, whose only purpose 

is to work as a “filter selectors”. These types of objects will often be able to 

replace the need to work with filters from the Criteria Bar. 

Furthermore, with the concept of Required Criteria, you can prevent certain 

objects to load huge, confusing and time-consuming amounts of data before the 

end-user have applied the required filters. 

The analysis below shows Revenue split on four different dimensions: 
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Drill down objects 

Instead of adding dimensions to the criteria bar, 

we will add 3 tables, containing dimension only. 

The simple table can be found in the Design 

ribbon in the Charts section. 

 

 

 

This table will allow the users to filter the data by drilling 

down on the countries in the table. 

 

 

 

 

The table uses the standard format defined for all cross tables. You can choose 

not to re-format but you can change the properties for the crosstab theme. 

 

The dialogue box offers many options for changing / adding various themes. 

When a new theme has been added, you can save it for later use. 
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However, this is not a crosstab but the column header has to be changed here. 

Click the element and choose the property to change. Here we want to change 

the font size for Column label 1. 

 

A simple way of changing the row formats is by right clicking a row 
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And then change the font in the exactly same way 

 

When the first table has been formatted, you can copy it (Ctrl+C -> Ctrl+V) and 

then re-define the table to change the dimension. 

You can clarify the purpose of the table by entering an appropriate dynamic 

caption. 
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Table header changed with Dynamic captions: 

 

The analysis is ready to use. You can experiment with the table placement in 

order to place them in the right spot and in the right order. 
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Required criteria 

The analysis has two cross 

tables with many rows. The 

amount of data in this demo 

version is limited, but in a 

live solution, the large 

amount of data can influence 

the load time of data in the 

analysis. 

You can work with Required 

criteria from the right-click 

context menu. 

 

 

 

 

 

In this example, the Product crosstab should show data only when a country has 

been selected. 

 

Notice the Custom text option in this example. 
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TARGIT Visualization Wizard                                                                                         Page 74 of 117 

In this example, custom text for missing required criteria has been added to the 

leftmost center table. The rightmost center table is using standard text for 

missing required criteria. 
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Criteria ranges with custom values 

Sometimes you need to specify a criteria that should 

include not only existing dimension members, but also 

potential future dimension members within a criteria 

range. 

In the example to the right, we are looking at a long list 

of current Customers. Currently, there are about 30 

customers whose first letter is a ‘G’, but in future we 

expect there to be more customers starting with a ‘G’. 

 

 

 

 

 

 

 

The standard criteria search functionality in TARGIT allows you to search for 

those starting with a ‘G’, but then you will only be able to select those of the 

current dimension members that match the search string ‘G*’. 
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Instead, you can use the Custom value option. The Custom value option works 

best with criteria ranges – i.e. with use of the Between or Greater than / Less 

than operators. 

To make sure that we select all Customers starting with a ‘G’ – current customers 

and future customers – we can set up the criteria range with Between operator 

and custom values like this: 
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Notice the handling of ‘Include’ on the two range end definitions. 

When a document with this type of criteria is opened, it will in fact do an 

alphabetical search on dimension members within the range. E.g., new 

customers ‘G&D fashion’ and ‘gZ Style’ will be included in this criteria. 
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Exercises Lesson 6 

(Screenshots and exercises are based on version 2019.0 demo data. If you are working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Task 1 

Create a Drill Down analysis as the one below. Data comes from the Sales cube: 

 

Save the analysis as Lesson 6 Drill Down Analysis. 
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Task 2 

Add Required Criteria to three of the objects: 

 

Save the analysis as Lesson 6 Required Criteria. 
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Task 3 

Open Lesson 6 Drill Down Analysis and do these modifications: 

• Turn the Salespersons cross table into a “Selector object” (which is in fact 

a horizontal bar chart). 

• Do something similar for the other two Selector objects. 

 

 

Save the analysis as Lesson 6 Drill Down Analysis with bar chart 

selectors. 

Tips: 

• Add a measure to the cross tables and change object type to horizontal 

bar chart. 

• In Chart Properties, these and other settings apply: 

o Add a proper Title. 

o Column width: Very wide. 

o Labels: Row member, inside placement. 

o Measure axes: 

▪ Maximum: 1. 

▪ Remove axis line and axis labels. 

o Dimension axis: 

▪ Remove axis line and axis labels. 
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Task 4 

From the Finance cube, you can create a crosstab 

showing Amount per Account, like the one picture 

to the right. 

 

Create a criteria, using Custom values ranges that 

will include: 

• All current/future Accounts starting with ‘2’. 

• All current/future Accounts starting with ‘50’. 

 

The result of current accounts will look like this: 

 

 

 

How do you set up such a criteria? 

 

Answer: _______________________________________________________ 
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Lesson 7: Slideshows 

The traditional channels for data distribution include end-users working 

interactively with TARGIT documents and dashboards and analyses being 

distributed, via scheduled jobs, as PDF files to external recipients. 

With Slideshow you can also include Info screens in your distribution channel 

list. Imagine Info screens in your workplace – in the canteen or on the 

production floor – running frequently updates of selected TARGIT dashboards. In 

addition to the pure information value, they will often have a motivating effect as 

well. 

Creation of Slideshows is initiated from the Start page’s New tab: 

 

  



 

TARGIT Visualization Wizard                                                                                         Page 84 of 117 

The documents to include in the Slideshow are then selected from the available 

folders. Please note that you must select a specific layout in case the document 

holds multiple layouts. 
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You can then save the Slideshow and have a TARGIT client to run it in a 

continuous loop on an info screen. 

 

Notice the option for creating a PowerPoint presentation. 

Note: Dashboard data will update for every loop of the Slideshow. Of course, 

this will only make sense if the underlying Data Warehouse is frequently updated 

as well. 
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Exercises Lesson 7 

(Screenshots and exercises are based on version 2019.0 demo data. If you are working on an earlier or later 

version you may need to subtract or add 1 year to achieve similar results.) 

Try out the Slideshow functionality. 

• Add some of the documents you created and saved in the previous 

lessons. 

• Save it as a Slideshow. 

• Run it as a slideshow on your own screen. 

• Try exporting it as a PowerPoint presentation. 



 

TARGIT Visualization Wizard                                                                                         Page 87 of 117 

Appendix 

Selected Visualization Objects 

In this lesson, you will learn about some of the different graphical object types 

and some of their special settings. 

The TARGIT client contains quite a comprehensive list of different object types 

for different visualizations, from which we will pick a few. The list of selected 

visualization objects will cover most of the standard settings for the most 

common object types. A few special object types may require additional 

explanations, and they have been picked as well. 

General chart properties 

The Column chart, Bar chart, Line chart and Area chart are very closely related 

and have essentially identical formatting options. On the following pages, you will 

see an example based on a Column chart. 

Right click on a chart to select Chart properties – or select it from the Properties 

Smartpad. 

 

If you select this option, you will open an object type specific formatting dialogue 

box. Although options may differ slightly from one object type to another, the 

most common ones are: Chart, Labels, Dimension axis, Measure axis and Colors. 
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Rather than going through every single chart property, let us have a closer look 

at this example: 

 

The column chart above has been formatted with these chart property settings 

(only where settings have been changed from default): 

• From the Chart tab: 

o The Title field has been used to produce the title on top of the 

chart. 

o The Profit Margin series has been moved to the Right axis and 

has taken a Spline visualization. 

• From the Labels tab: 

o Revenue and Profit labels are showing Measure value and have 

Placement Inside. 

o Mouse over for Revenue has been set to Member: Percent 

(column). 

o Furthermore, labels have been formatted with regard to Number 

format, Font size and Font color. 

• From the Measure axes tab: 

o The Right axis Maximum has been set to 100, with an Interval 

of 10. 
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Bullet Graph 

The Bullet Graph is a special visualization object that can be used to monitor a 

KPI against a Goal, while at the same time displaying intervals for e.g. below 

expectations, within accepted range and above expectations. 

If you add a dimension to a Bullet graph, the visualization of the Bullet graph will 

repeat itself as many times as you have dimension members. 

The Data tab of the Bullet Chart dialogue box will allow you to select what data 

to display in the graphs. 

The term Rows refer to rows of dimension members in the underlying 

crosstable. “1” means the first row, while “-1” means the last row. E.g. From “2” 

to “-3” means from second row to third last row. The locker symbols can be used 

to lock the range to specific members, e.g. from “Product C” to “Product K”. 

The Horizontal bar setting should usually contain the KPI measure you would 

like to monitor in the Bullet graph. 

The Vertical bar setting determines the position of the goal bar in the Bullet 

graph. This is usually related to a second measure, but it could also be a fixed, 

custom value. Sometimes, the goal bar is not needed at all and can be left out if 

desired. 

The Distribution option offers six different predefined distribution intervals. It 

will color the background of the Bullet graphs accordingly. 

 

Note: In this screenshot, the data in underlying crosstab has had a descending 

sort order applied to Revenue. 

The Labels tab of the Bullet Chart dialogue box contain options for displaying 

text with the Bullet graph: 
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• Leading text: The text in front of each Bullet graph. 

• Lower text: The text below each Bullet graph. 

• Mouse over: The text that displays when you hold your mouse cursor on 

top of one of the graphs. 

All three labels’ font settings can be formatted individually. 

 

Note: Number formatting is done with the standard Number formatting option 

from the Properties Smartpad. 

The Axis tab is where you control the appearance of the horizontal axis of the 

Bullet graph. 

• Minimum / Maximum: The range of the graph. Choose from a number 

of predefined settings or enter your own custom value. 

• Ticks: These are the numbers along the axis. Can also be set to none. 
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• Step size: The range between each tick. Apart from the Automatic step 

size, you can also define your own, custom step size – either by 

modifying the auto setting or by entering a fixed value. 

 

The Colors tab offers a number of predefined themes for coloring the various 

elements of the Bullet Chart, but you can also select your own, custom colors. 

 

 

In many of the Custom fields, you can actually make small calculations based on 

some of the other settings in the Bullet Graph dialogue box. These settings are 

referred to as value placeholders. 
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The value placeholders you can use are: 

• Value – the value of the measure you selected for the Horizontal bar on 

the Data tab. 

• Goal – the value (measure or custom) you selected for the Vertical bar 

on the Data tab. 

• Min – the value specified as the range minimum on the Axis tab. 

• Max – the value specified as the range maximum on the Axis tab. 

• Interval1, Interval2, etc. – the values specified for each interval on 

the Data tab. 

As an example, the interval limits of Interval 1 and Interval 2 has been set as 

Goal plus/minus 10 percent respectively: 

 

In fact, the Bullet Chart offers many customizable options, e.g. here, the Lower 

Text option has been customized to show data for both measures: 
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Area map chart 

In TARGIT Decision Suite 2017, objects got a big boost in terms of visualization 

options. 

Two of these are maps based on the scalable vector graphics, also known as SVG 

files. They are available as two new object types: area map chart or Image chart. 

TARGIT client offers a number of geographical maps upon installation. These 

maps are designed so that they show a colored area and not just a colored dot. 

It is, however, not limited to the geographical map. You can use pictures of just 

about anything you want to use for displaying data. 

For detailed instructions on how to download and edit the map on this blog: 

https://www.targit.com/en/blog/2016/11/data-visualization-with-svg-files 

General map options 

Create an area map chart showing No of Sales per Customer hierarchy on the 

Country level. 

 

  

https://www.targit.com/en/blog/2016/11/data-visualization-with-svg-files
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When we fetch data, the default setting is to show the world map, where the 

countries are marked by individual colored areas. 

 

 

Another default setting is “Auto-zoom” that automatically zooms in to a specific 

area of the world map if you filter the data on i.e. Europe. 
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Changing the map image 

Since we only show data for Europe or if we only had data from Europe, we 

might want to change the map image. To change the image, simply change the 

Chart properties. Click “Change map image” 

 

And select the new map. 

 

It is possible to add new images. Click… 

 

… and then 
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Mapping of dimension values 

The first time you use an image the dimension values must be mapped. 

Create a new Area map chart showing No of Sales per Customer Region 

(attribute). Add a criterion to show data for Germany only. 

 

When we fetch data the default world map is shown. To change the map to 

Germany, navigate to the chart properties and open the Custom maps folder. 
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At first the map will be empty with no locations mapped. In the chart properties 

click Edit locations. 

 

The unmapped dimension values are shown in the dialog box. If we click Auto 

Map TARGIT will match the dimension values up with the individual areas on the 

map and apply the locations. There might be dimension values left that have not 

been mapped. These values can be mapped manually by using drag and drop. 

On this map, you can identify locations with mouse over on the area. 

 

You can also double click an element if you want to see a list of the locations. 
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Once you are done mapping all you have to do is to save the locations. 
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Labels formula syntax 

Column/row and axis calculations 

List of column calculations 

These refer by default to column 1 in your crosstab – note that you can work 

with lookup values to point to a particular column or row. 

column calculations Description 
column.sum Sums up the total of the column 
column.avg Calculates the average of the column 
column.min Returns the minimum value of the column 
column.max Returns the maximum value of the column 
column.stdev Retuns the standard deviation of the column 
column.median Returns the median of the column 

column.percentile(pct) E.g. column.percentile(0,25) returns 25% 
percentile 

column.count Returns number of values in the column 
column.membercount Returns numbers of members in the column 

 

 

row calculations Description 
row.sum Sums up the total of the row 
row.avg Calculates the average of the row 
row.min Returns the minimum value of the row 
row.max Returns the maximum value of the row 
row.stdev Retuns the standard deviation of the row 
row.median Returns the median of the row 
row.percentile(pct) E.g. row.percentile(0,25) returns 25% percentile 

row.count Returns number of values in the row 
row.membercount Returns numbers of members in the row 

 

axis calculations Description 
axis.sum Sums up the total of the axis 
axis.avg Calculates the average of the axis 
axis.min Returns the minimum value of the axis 
axis.max Returns the maximum value of the axis 

axis.stdev Retuns the standard deviation of the axis 
axis.median Returns the median of the axis 
axis.percentile(pct) E.g. axis.percentile(0,25) returns 25% percentile 
axis.count Returns number of values in the axis 
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Gauges – for Dashboards 

A Dashboard is an analysis like any other analysis in the TARGIT Decision Suite. 

However, it is an analysis that has been designed to give a very high-level 

overview of your KPIs (Key Performance Indicators). 

Some object types are better at showing high-level information than others, and 

quite often, you will see the gauge object type being used in dashboard analyses. 

Start with a basic crosstab 

Even though you can create a gauge on top of a very complex crosstab, it is 

rarely necessary to do so. If the gauge is supposed to show three KPIs – then, 

why not let the basic crosstab reflect the same simplicity? 

The shown simple crosstab is based on the Revenue measure and a comparison 

of LYTD and YTD: 

 

The Growth Percent calculation comes from the list of predefined calculations. 

Furthermore, three color agents have been added to the calculation: 

 

The blue color agent have been selected carefully to match the gauge object we 

are going to apply in a minute: 
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As we are going to create a complete Dashboard with these KPIs – one gauge 

per Product Group – we will need to add Local Criteria to each object: 

 

 

Gauge Properties 

At this point, we may change the crosstab to a Gauge object type, and open the 

Gauge Properties dialogue box. 

 

The Gauge Properties dialogue box has three tabs on the left hand side: General, 

Scale & Labels and Values. 
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General 

The first thing to do is to select the proper visualization type, in this case the 

Icon – Sq Banner Blue Selected. 
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Values 

Next, we should jump to the Values tab. Initially, we can only see the last value 

from the crosstab, the Growth Percent. While this is one of the KPIs we would 

like to see in the gauge, we would also like to see the Revenue values of YTD 

and LYTD. 

Click the ‘+’ button twice to add Revenue twice. 

 

Notice: To make the Revenue value show YTD and LYTD respectively, we will 

need to adjust column reference for one of the entries: “2 columns from the 

right”. 
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Scale and Labels 

Now, let us turn the attention to the Scale & Label tab. At this point, ignore the 

Minimum and Maximum settings. 

The selected gauge visualization has been designed to hold seven separate 

values – as can be seen from the small preview on the left hand side of the 

Gauge Properties dialogue box. 

These seven values corresponds to the seven Labels entries on the Scale & 

Labels tab – from Header 01 and down to Value 03 Label. 

Make sure that the Value 02 and Value 03 reflects the two YTD and LYTD values 

of Revenue. 

 

To make text appear in the places where we are currently seeing “27.94”, we will 

have to tweak the number format a bit. 

To access number format for Header 01, click the hash mark: 
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For this gauge, due to the JEANS local criteria, we would like the header to be 

“JEANS”: 

 

Notice: The double syntax of “JEANS”;”JEANS” is necessary to avoid undesired 

minus signs in front of this text. 

Likewise, we can change number formatting of Value 01 Label, Value 02 Label 

and Value 03 Label to display the text we would like to see: 

 

Notice: It really does not matter what value has been selected for these labels as 

they are going to be overwritten by pure text anyway. 
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Now, by copying the gauge and modifying the local criteria and the Header text, 

we can get a complete dashboard like this:  
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Gauges – build your own 

Of course, you are not limited to the set of built-in gauges – you can build your 

own gauge as well. 

To prepare yourself for building your own gauge, you must first consider which 

graphics you will need to include in the gauge. 

The following example is using two separate graphics: 

• One is a background “wallpaper” – in this case a four-rowed banner, each 

row in different colors. By the way, this type of graphics is easily made as 

a table in PowerPoint, which is then exported to a graphics format, e.g. a 

.png file. 

• The other is a white circle. The white circle (with transparent background 

color) will work as an indicator in my new gauge. It will change color 

according to data values. 
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Gauge Builder App Download 

You will need TARGIT’s Gauge Builder App to create new, custom gauges. 

Download and install it from http://appstore.targit.com. 

 

This is the app you will need to download and install: 

 

  

http://appstore.targit.com/
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After installation, it is recommended to run the TARGIT Gauge Builder in 

Administrator mode: 

 

 

Use the app to create a new gauge: 
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Choose the Icon type. The Speedometer type should be picked only if a 

speedometer with moving needles is specifically needed. 

 

If you add your background image at this point, you will get a nice starting point 

once you get into the app. 
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As soon as you get into the app, you may want to add extra images as the first 

thing. The colorable circle must be added while standing on the “State 1” Layer. 

 

Make sure that the “Color” property for the circle is enabled. 
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Next, drag a Scale onto your background image. 

 

A Scale comes in two flavors: Labels or Values. In this case, pick Value. Label is 

intended for labels along a speedometer perimeter only. 
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Choose Name, Font and Number Format for the inserted Scale. You should 

consider selecting some settings that you think will cover most end-user needs, 

as this will become the default formatting for the gauge when used in the 

TARGIT client. Of course, in the client, you can overwrite these default settings 

with settings of your own, if necessary. 
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Furthermore, consider if the inserted scale is supposed to show a value (number) 

or a text. 

For numbers, simply pick a suitable default number format. 

For texts, you may need to pre-format it in this way: 

 

The same text is inserted twice. This is necessary in order to prevent texts to 

become pre-fixed with a minus sign. 
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As texts or numbers may grow in size (due to number of characters or changed 

font size), you can set their growth directions: 
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